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Introduction
This introductory chapter includes general helpful information about how to use this help system, how to contact onOne Software, how to install and access the
software, etc. It covers many of the foundation topics that you will need to understand to get started.
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Using the Help System
This user guide is html based and readable in most web browsers. On the left side, you will see a table of contents that make it easy to find the section you are
looking for. The table of contents is hyperlinked and will take you to the specified section by clicking on them. The main body of the page will show you the
content you have requested. Use the scroll-bar at the right to scroll down for additional content. You may see hyperlinks in the body text. They will be blue and
underlined. Clicking on one of these hyperlinks will take you to more relevant information.
You use the same forward and back buttons in your browser to navigate this user guide as you would a regular web page. You can even bookmark pages so
you can find them quickly later.
If you don't see what you are looking for in the table of contents, try the search field at the upper right. You can type in what you are looking for and an index
of pages will be created automatically that contain your search term.

Printing the Manual
You can print individual pages by pressing the Print button at the top of the page. A complete printable PDF version of this user guide is available in the user
guide section of the onOne website. This version may be downloaded and viewed when you do not have an internet connection. The PDF version may also be
installed on your tablet or eReader device for viewing off our computer.

Contacting onOne Software
At onOne Software, we value our customers and offer a variety of ways to be contacted.
• Visit our company website at:
www.on1.com

• For technical support please visit:
www.on1.com/support

on1, Inc.
15333 SW Sequoia Parkway Suite 150
Portland, OR 97224

© 20072015 onOne Software, Inc. All rights reserved. onOne Software is a registered trademark of onOne Software, Inc. The onOne Software logo are trademarks
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of onOne Software, Inc. Adobe, Photoshop, Photoshop Elements, Lightroom are either registered trademarks or trademarks of Adobe Systems, Incorporated in the United
States and/or other countries. Mac OS X, the Mac logo, iPhoto and Aperture are trademarks of Apple, Inc., registered in the U.S. and other countries. Microsoft, Windows
7, Windows 8 are registered trademarks of Microsoft Corporation. All other trademarks are the property of their respective owners. The activation system used
by onOne Software, Inc. is licensed under Patent No. 5,490,216. For a full list of license disclosures view the LICENSE.TXT file installed with the software.

Additional Help

Technical Support
Contact technical support at www.on1.com/support or by filing out a request form.

Knowledge Base
Search the Knowledge Base for common issues, tips & tricks, and compatibility questions.
Frequently Asked Questions
Check the list of Hot Topics on the onOne web site. This covers the most frequently asked questions.

Video Tutorials
Visit the onOne University for free online video tutorials and archived webinars. Many users find these to be the best and fastest way to get
started and learn new techniques.

System Requirements

Operating System
Processor
RAM
Hard Drive

Display
Optional Application
Integration
Other

Minimum

Recommended

Mac OS X 10.8, 10.9, 10.10
Windows Windows 7 or Windows 8
current maintenance releases, 64 bit only
Intel Core 2 Duo, Xeon or better
processor(s)
8 GB RAM

Mac OSX 10.9, 10.10
Windows Windows 7 or Windows 8
current maintenance releases, 64 bit
Quad-core Intel Core i5, Xeon or better
processors(s)
8+ GB RAM

1 GB for installation

1 GB for installation
Fast 7200 RPM or SSD drives
10% of boot volume should be free for
scratch disk
OpenGL 2.0 compatible video card with 256 OpenGL 4.0 compatible video card with
MB dedicated video RAM, 1280x720
1GB dedicated video RAM, 1920x1080
resolution
resolution
Photoshop CS6, CC, CC 2014
Photoshop CC, CC 2014
Photoshop Elements 11, 12, 13
Photoshop Elements 12, 13
Photoshop Lightroom 4, 5, 6
Photoshop Lightroom 5, 6
Apple Aperture 3.6
Internet connection for activation, auto
Wacom tablet for pressure sensitive
update checking, content downloads and
input
tutorials.
Hardware display calibration tool

About Windows Video Cards
If you are using Perfect Enhance from a Windows based computer, it is important that you have the latest drivers for your video card installed to get the best
performance. Check with your video card manufactures website for the latest drivers. Be sure your video card is OpenGL 2 compliant and has 256MB or more of
dedicated VRAM. Many integrated video cards on low-end laptops may not meet these requirements.

Installation
To install Perfect Enhance, double click the installer icon and allow the installer to guide you. You may have downloaded the installer from the on1, Inc. website
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or it may be on a DVD if you elected for a physical shipment.

You should close any supported host applications such as Photoshop, Lightroom or Aperture as well as any standalone versions of
onOne products before installing or updating.

Mac OS X
The application is installed in the Perfect Enhance folder in the Applications folder.
All plug-in files for supported host applications (such as Photoshop, Lightroom, Aperture, and Photoshop Elements) found during the installation process
will be installed automatically. You will see a summary of installed plug-ins at the end of installation.
If a previous versions of Perfect Enhance is found, it will be maintained or replaced based on your preference during installation.
Support files are installed into /Library/Application Support/ and ~/Library/Application Support/ folder.
Windows
The application is installed in the Perfect Enhance directory in the onOne Software directory in the Program Files directory.
All plug-in files for supported host applications (such as Photoshop, Lightroom, Aperture, and Photoshop Elements) found during the installation process
will be installed automatically. You will see a summary of installed plug-ins at the end of installation.
If a previous versions of Perfect Enhance is found, it will be maintained or replaced based on your preference during installation.
Support files are installed into \ProgramData\onOne Software\.

Uninstalling
To uninstall Perfect Enhance, follow these instructions.
You should deactivate your product before uninstalling. This will allow you to transfer your license to another computer.

Mac OSX
1. Go to the Applications/Perfect Enhance/Documentation folder.
2. Double click on the Remove Perfect Enhance application.
Windows
1. Go to Control Panels.
2. Under Programs select Uninstall a program.
3. In the list that comes up select Perfect Enhance and then click on the Uninstall button.

Licensing and Registration
Perfect Enhance will operate as a trial version for 30 days from when it is installed. If you have purchased Perfect Enhance, you will want to license it so you
can continue to use it past the trial period. When you install Perfect Enhance it will prompt you to license it. Simply click on the license button and enter your
license code. Your license code can be found in your order confirmation email if you purchased the download version directly from on1, Inc. If you purchased a
physical copy of Perfect Enhance, a sticker on the information card will have the license code on it. Your license code allows you to install Perfect Enhance on
two computers. When you enter your license code, Perfect Enhance communicates with the on1, Inc. activation server and will activate your software. Your
software must be licensed and activated to function past the trial period. If the computer you are activating does not have access to the internet, you can
manually activate your software by following the manual activation instructions in the license dialog.
If you wish to move your copy of Perfect Enhance from one activated computer to new computer you will need to deactivate it first. Deactivation is a simple
process. Simply open Perfect Enhance and select Deactivate from the Help menu. This will deactivate Perfect Enhance on the current machine, allowing you to
install and activate it on another machine.
If you lose your activation code, have your computer stolen and can not deactivate it, need to install on more than two computers or have other activation
issues please contact on1, Inc. customer by visiting the support section of the on1, Inc. website.

Product Improvement Program
We believe that the best products are made by listening to our customers. We use many methods to gather your ideas and feedback including: emails, surveys,
direct conversations, market analysis and the Product Improvement Program. The Product Improvement Program is built into our software and gathers
information about how our software is used. It is the most accurate way for us learn what features are important to you and how our products fit into your
workflow.
Enrollment in the program is voluntary. When you participate, we collect basic information about how you use our programs and basic information about your
computer. This information helps us learn what features are important to you and how we can make our software easier to use. No personal information is
collected and you will not be contacted.
You can choose to participate in the Product Improvement Program the first time you launch an on1, Inc. product. You can change your participation later, just
click the Help menu, then Help Improve on1, Inc. Products.
You can learn more about the Product Improvement Program here.
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Opening Files

Supported File Types

Perfect Enhance uses the Photoshop (PSD) file format as its default file type. The Photoshop file format is a commonly supported, publicly documented file
format that is also the standard file for Adobe Photoshop. It is also supported by Photoshop Elements, Lightroom, Aperture and many other image editing
applications. It supports multilayered images and layer masks making it the perfect format for durable, adjustable imaging. Perfect Enhance also supports the
opening and saving of the following file types, in RGB either 8 or 16-bits per pixel.
Photoshop (PSD)
Photoshop Large Document (PSB)
Tagged Image File Format TIFF (TIF)
Joint Photographic Experts Group JPEG (JPG)
Portable Network Graphic (PNG)
Camera Raw files from over 200 digital cameras
Photoshop PSD files will maintain all the layers and layer masks you create in Perfect Enhance and are recommended as your main file format. Photoshop files
may also be saved as a Smart Photo , which is an onOne specific variant of the Photoshop format that allows you to re-edit your settings at a later date. If your
saved file will be larger than 2 GB or 30,000 pixels on a side, your image will automatically be saved in the .PSB or Large Document format. This is a newer
version of the PSD file format and still maintains all your layers and masks.
You can use the Edit a Copy or Save As command to save flattened TIF and JPG files or PNG files with transparency. Camera raw files can only be opened, not
saved directly. They must be saved as another file type.

Opening Files
You may open an existing file in several ways depending on which product you are using.

Perfect Photo Suite
Perfect Browse
Perfect Layers
Premium Editions of:
Perfect B&W
Perfect Effects
Perfect Enhance
Perfect Portrait
Perfect Resize
Perfect Effects Free
Basic Editions of:
Perfect B&W
Perfect Effects
Perfect Enhance
Perfect Portrait
Perfect Resize

Open
Command in
the File Menu

Open via
Perfect
Browse

Drop on the
Application
Icon

Plug-in from
Adobe
Photoshop

Plug-in from
Adobe
Lightroom

Plug-in from
Apple
Aperture

Yes
Yes
Yes
Yes

Yes
Yes

Yes
Yes
Yes
Yes

Yes

Yes

Yes

Yes

Yes
Yes

Yes
Yes

Yes
Yes

Yes

Yes

Yes

Yes
Yes

When opening an existing PSD file that has been editing in Photoshop it may contain unsupported layer types such as text layers, adjustment
layers, etc. you will see a warning. You can still open a flattened version of the image if this happens. You can learn more here.

Opening Options
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When you open a file(s) you will be presented with the dialog to the
right. It allows you to choose to work on the original file, a copy, or to
stack the files together as layers.
Edit a Copy: A copy of the original file is made using the Copy
Options below and saved in the same folder as the original.
Edit Original: The original file is edited directly. This overwrites
the original file with your changes. This option is disabled for
Raw or read-only files.
Add as a Layer: The original file is added as a layer(s) into the
current image in Perfect Layers. If no image is opened, a copy
of the first image in your selection is created.
If you select to open a copy, you can control the file type, color
space, bit-depth and resolution. If you have multiple files selected,
they will all be handled the same way.
Checking the "Don't ask me again" box will bypass this dialogue box in
the future and use the current options selected the next time you
open an image.

Smart Photos
Smart Photos are a special PSD format that allows you to save your settings and masks from each module that you use so you can go back and re-edit them
later. Any settings you make, including masks and control points, are readjustable later.

Creating a Smart Photo
To create a Smart Photo, select the Smart Photo checkbox in the Edit What dialog when you open an image. If you access Perfect Enhance as a plug-in from
Lightroom or Aperture you have the choice each time you send a Photoshop file. You can also convert a layer in Perfect Layers to a Smart Layer, which
converts the image to a Smart Photo, if you have Perfect Layers.

Re-Editing a Smart Photo
There are several ways to open and re-edit a Smart Photo depending on your product configuration:

If you have the Perfect Photo Suite you can re-edit a Smart Photo by double-clicking on the module entry in the Smart Photo
History pane in Perfect Browse or the Layers pane in Perfect Layers or just click on the module in the module selector.
If you have a standalone application like Perfect Effects, Perfect B&W, Perfect Portrait or Perfect Enhance, simply open the
image and your settings will be reloaded automatically.

Similar to Smart Objects in Photoshop, Smart Photos have certain limitations. You cannot use any tool that will change the original pixels, such as
crop or transform. This includes the retouching tools in Perfect Layers, however you can use them in Portrait and Enhance. You cannot change the
image size or proportions either, so no crop or Resize.

Module Selector
The Module Selector is a feature of the full Perfect Photo Suite only.

The Perfect Photos Suite is a complete photo editor. It uses a modular approach, allowing each module to focus on one task. This makes accomplishing the task
easier by removing unnecessary tools and giving access to just what you need to get the task done. When used as a standalone application, Perfect Browse is
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the default module upon first launch, it is used to navigate your drives and cloud services to find images to begin working. In the Preferences you may change
the default startup module to Perfect Layers. If you prefer a layered workflow you can use the Layers module as the heart of your workflow, similar to using
Adobe Photoshop. Depending on how you access the Perfect Photo Suite you may never notice Browse or Layers.

The Module Selector
If you access the Perfect Photo Suite as a standalone application you
will start in Browse or Layers module.
When you are ready to edit an image you will select the module you
wish to use from the Module Selector in the upper right corner of the
main window. You can easily switch between modules by clicking on
another in the Module Selector. This allows you to perform multiple
tasks during the same editing session.

This is the module selector from the Perfect Photo Suite. It contains all of the
available modules that onOne Software makes. If you have purchased a single
product, you will only see that product module and Perfect Layers in your module
selector.

If you access the Perfect Photo Suite as a Photoshop Plug-in you see the Module Selector, but it will be disabled, you can only use one module at a time through
Photoshop. The Module Selector will also be disabled if you use the following modules through Lightroom or Aperture:
Perfect Portrait
Perfect Effects
Perfect B&W
Perfect Enhance
Perfect Resize
When you access these modules, you use them on their own and then return back to Lightroom or Aperture directly. Your file will be saved and closed
automatically.

If you want to have access to all your modules during an editing session from Lightroom or Aperture, select the Perfect Photo Suite or Perfect Layers
plug-in. This will start you in Perfect Layers and the Module Selector will be visible, allowing you to access all of the installed modules.

Using as Standalone
Perfect Enhance can be used as a standalone application without the need of Photoshop, Lightroom or other host application. To launch it follow these steps:

Mac OS X
1.
2.
3.
4.

Open your Hard Drive.
Navigate to the Applications folder.
Navigate to the Perfect Enhance folder.
Double click on the Perfect Enhance application icon.

You can add Perfect Enhance to your dock for easy access by clicking and holding the icon in the dock, then select the Keep In Dock option. If you use
Launchpad it can be found there as well.

Windows 7
1. Go to your Start Menu.
2. Select the onOne Software group.
3. Select Perfect Enhance.
If you selected the "Add Icon to Desktop" option during installation you can also access Perfect Enhance from there.

Windows 8
1. Open the Start screen by pressing the Window key.
2. Select Perfect Enhance.
If you selected the "Add Icon to Desktop" option during installation you can also access Perfect Enhance from there.

Using with Adobe® Photoshop®
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If you have the Premium Edition of Perfect Enhance, you can access it as a plug-in through Adobe® Photoshop® or Photoshop® Elements®.
This includes the onOne panel for Photoshop for fast access to plug-ins and their presets. As a Photoshop plug-in you can use modules in the
Photoshop workflow. This includes using selections and masks as well as Smart Objects and Smart Filters. You can also record actions for
automating and batch processing.
If you do not have the Premium Edition of Perfect Enhance and would like to use it inside of Photoshop, contact onOne Customer Service about
upgrading to the Premium Edition.

To use Perfect Enhance inside of Adobe
Photoshop follow these steps:
1. Open the image you want to work on.
2. Select the layer you want to work on.
Generally Perfect Enhance works on a
copy of your selected layer, not the
entire image.
3. From the File menu, select Automate,
and then the module you would like to
use.

To use Perfect Enhance inside of Adobe
Photoshop Elements, follow these steps:
1. Open the image you want to work on.
2. Select the layer you want to work on.
Generally Perfect Enhance works on a
copy of your selected layer, not the
entire image.
3. From the File menu, select Automation
Tools, and then the module you would
like to use.

Perfect Layers and Browse are not accessible from Adobe Photoshop or Photoshop Elements.

onOne Panel

Users of Adobe Photoshop can also access Perfect Enhance as plug-ins using the onOne Extension
Panel. This provides fast access to the Perfect Enhance and its presets. To access the onOne panel, go
the Window > Extensions menu in Photoshop and select onOne.
The onOne panel behaves just like any other panel in Photoshop. It can be minimized or nested with
other panels. To access a module, simple double-click on it. To use a preset, single click on the module
name. A menu of available presets will be displayed. Simply double-click on one to apply it to your
selected layer.

If you wish to record actions using Perfect Enhance be sure to access it from the File >
Automate menu when recording.

Using with Adobe® Lightroom®
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If you have the Premium Edition of Perfect Enhance you can access Perfect Enhance as a plug-in inside of Lightroom. This provides an
integrated, round-trip workflow.
Perfect Enhance is the perfect companion for Adobe Photoshop Lightroom. It integrates tightly with it and provides a seamless experience for
enhancing your images. There are several ways to use Perfect Enhance with Lightroom.

Plug-In Extras
Perfect Enhance can be accessed from the File > Plug-in Extras menu.
This is the preferred way to access it. It gives you access to all installed
modules and has the most flexibility in how the files are handled. To edit
an image in Perfect Enhance follow these steps.
1. Select the image in Lightroom.
2. Go the File menu and select the Plug-In Extras flyout.
3. Select the module you would like to use.
When you access Perfect Enhance as a plug-in from Lightroom the
module selector is only available for Perfect Layers or Perfect Mask.
When you select one of these modules you can use as many modules as
you desire during the same editing session. At the end of the editing
session you must save and close the image from the Perfect Layers
module.
When you select a module other than Perfect Layers or Perfect Mask
your image will be sent to it directly and when you press Apply, the
image is saved and closed automatically and you are returned back to
Lightroom.
Selecting Multiple Images
If you have multiple images selected, the behavior varies depending on
which modules you select.
Perfect Layers or Perfect Mask: Each file will be opened in its
own tab. Then you may access any modules available in the
Module Selector.
All other plug-ins: Each image is opened in turn and you may
adjust the settings on an image by image basis.

Lightroom Plug-in Preferences
When you use Perfect Enhance through the Plug-In Extras menu
there are important file handling options that are controlled in the
Preferences dialog of the Perfect Layers module. These need to be
configured in advance based on your desired workflow.
File Type: The file type drop-down menu determines what
type of file will be created. The default is PSD, which
maintains layers. You can also select JPG or TIF if you prefer
those formats and are not concerned about maintaining
layers. The last option is same as source, which maintains the
file type of the original file, except for Camera raw files which
are saved as PSD.
Color Space: The color space drop-down menu determines
what RGB working color space is used; Adobe RGB 1998,
sRGB or ProPhotoRGB.
Bit Depth: The bit-depth drop-down menu determines the
bit depth, either 8-bit or 16-bit per pixel.
Resolution: The resolution drop-down menu determines the
resolution of the file.
Stack with Original: When enabled, the new image is
stacked with the original image, making it easier to organize.
Use Original for Single PSDs: When enabled, if you select
a single PSD file, it will be edited directly, rather than having
a copy made.

External Editor

You can also access modules as external editors for all modules except
Perfect Layers or Perfect Mask. You can access them from the Edit In...
contextual menu. These behave similarly to the plug-ins in the Plug-In
Extras menu but ignore the preferences set in Perfect Layers. Instead
you have the option to control a subset of these options each time you
access a module, in the same way you do when you access Photoshop
or any other external editor.
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Batch Processing
There are two ways to batch process multiple images in Lightroom with Perfect Enhance.

Perfect Batch
Perfect Batch is the preferred way to batch process. You start with a
selection of images in Lightroom or folder on disk, then batch-process
them with multiple modules at the same time to solve complex
workflows. For example a portait photographer can prepare images for
a sales session by retouching every face, adding their stylized look and
output small JPGs with their logo watermark, all in the same batch
process. You can access Perfect Batch from the File > Plug-In Extras
menu in Lightroom. You can learn more about using in the Perfect Batch
section of this user guide.
Key batch processing features include:

Start with a selection of images from Lightroom or
any folder you select.
Batch process with a single module for simple jobs or
create workflows where you string multiple modules
together.
Save workflows to use over and over.
Pause on the first image to confirm your set-up, then
automatically process the rest to match.
Add a visual watermark, like your logo, to every
image.
Edit files in place or create new files with different
size, name or file type.

Lightroom Export
You can also batch process with a single module through the Export
menu in Lightroom. This is useful if you need to remove metadata or are
more comfortable with Lightroom's Export. Batch processing through
Export is driven by presets, so you need to create a preset that
accomplishes the work you desire first.
1. Select the images you wish to batch process.
2. Go the Export under the File menu.
3. At the top under the Export to drop-down, select the module to
use.
4. Complete the module specific options below. These will start
with the preset, followed by options for selecting the export
location, file naming, file size, etc.
5. Press the export button.

You cannot save Lightroom export presets or use
the Export with Previous option.

Using with Apple® Aperture®
If you have the Premium Edition of Perfect Enhance you can access Perfect Enhance as a plug-in inside of Aperture. This provides an integrated,
round-trip workflow.
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Perfect Enhance integrates tightly with Apple Aperture and provides a seamless experience for enhancing your images.
Perfect Enhance can be accessed from the Photo > Edit with Plug-In menu. To edit an image in Perfect Enhance follow these steps.
1. Select the image in Aperture.
2. Go the Photo menu and select the Edit with Plug-In flyout.
3. Select the module you would like to use.
When you access Perfect Enhance as a plug-in from Aperture the module selector is only available for Perfect Layers or Perfect Mask. When you select
one of these modules you can use as many modules as you desire during the same editing session. At the end of the editing session you must save and
close the image from the Perfect Layers module.
When you select a module other than Perfect Layers or Perfect Mask your image will be sent to it directly and when you press Apply, the image is saved
and closed automatically and you are returned back to Aperture.

Selecting Multiple Images

If you have multiple images selected, the behavior varies depending on which modules you select.
Perfect Layers or Perfect Mask: Multiple images will be opened in separate tabs.
All other plug-ins: Each image will open in a series so you can adjust the settings on each image.

The file type, bit-depth and color space of the image is determined by the preferences in Aperture for external editors. Perfect Enhance will
maintain the file type, either PSD or TIF automatically to support compatibility with plug-ins from other manufactures. Keep in mind only PSD files
store re-editable layers and mask.

Batch Processing
Perfect Batch is the preferred way to batch process. You start with a
selection of images in Aperture or folder on disk, then batch-process
them with multiple modules at the same time to solve complex
workflows. For example a portait photographer can prepare images for
a sales session by retouching every face, adding their stylized look and
output small JPGs with their logo watermark, all in the same batch
process. You can access Perfect Batch from the Photo > Edit with Plugin menu in Lightroom. You can learn more about using in the Perfect
Batch section of this user guide.
Key batch processing features include:

Start with a selection of images from Lightroom or
any folder you select.
Batch process with a single module for simple jobs or
create workflows where you string multiple modules
together.
Save workflows to use over and over.
Pause on the first image to confirm your set-up, then
automatically process the rest to match.
Add a visual watermark, like your logo, to every
image.
Edit files in place or create new files with different
size, name or file type.

Using with Other Applications
You can use Perfect Enhance as an external editor with many other workflow applications such as Adobe Bridge or Apple iPhoto. First check the application user
guide to see if it supports external editors. It should detail how to configure the host application to use an external editor. Generally this will include selecting
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Perfect Enhance setting the file type to send to it. It is best to use PSD files if supported. Below are the instructions for configuring iPhoto.

1. Open the Preferences dialog, from the iPhoto menu.
2. Click on the Advanced tab.
3. From the Edit Photos: pop-up select the In Application... option
(note if you have ever selected another external editor, it may
be listed here instead.)
4. From the Choose dialog that appears, navigate the the Perfect
Enhance folder, inside the Applications folder and select
[Product Name].
5. In the RAW Photos: option, uncheck the Use RAW when using
external editor option, and check the Save edits as 16-bit TIFF
files option .

Printing
You can print your photos to your printer using the Print function.
1. Select Print from the File menu.
2. Select your printer from the Printer pop-up.
3. Press the Print Setup button to adjust printer specific options
such as paper size and type and printer specific color
management options.
4. Adjust the number of copies, orientation and output
resolution.
5. In the Print Area section set the area you would like to fill with
image. The preview on the left shows the paper size and
margins as well as the print area and how the image will fit or
fill the print area.
6. Select the output Printer Profile and Rendering Intent to
properly adjust the photos colors to your printer and paper
combination. You may also select the Printer Managed Color
option to let your printer driver manage the color instead.

Tip: If you have already cropped and sized your image to your desired print area size, simply set the width and height to match in the Print Area
section.

Managing Extras
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What are Extras?
The Extras Manager let's you import and manage
your own Extras content. Extras are:
Backgrounds that can be imported and
used in Perfect Layers.
Borders than can be imported and used in
Perfect Layers, Perfect Effects and
Perfect B&W.
Textures that can be imported and used
in Perfect Layers and Perfect Effects.
Presets for Perfect B&W, Perfect Effects,
Perfect Enhance, Perfect Portrait and
Perfect Resize.
Extras can be content that you download from
the onOne website or content that you create on
your own.
The Extras manager lets you create categories
for each Extra type, import files as extras and
delete user-added extras you no longer want.
You can access the Extras Manager from the File
menu in Browse and Perfect Layers or the Preset
menu in modules that use presets.

How to Import Extras
Importing extras is simple. Start by opening the Extras Manager then follow these steps.
1. Select the type of extras you wish to import in the left column (Backgrounds, Borders, etc.) You can only import extras of one type at a time.
2. Click on the Import button in the footer of the left column. A Finder or Explorer Window will appear where you can select the files to import. If you
want to import an entire folder, click into the folder then select the first file, then shift-click on the last file. Click import when you selection is
complete
3. Select a category for your extras to live in. This is where you will be able to find it inside of the Perfect Enhance. You can select from an existing
category or create a new one.
When your extras have been imported you will see them in the Extras Manager in the category you selected, in the type of extra they belong to.

What Type of Images Can I Import as Extras?

Backgrounds and Textures may be any image file that Perfect Enhance can open including jpg, tif, raw or psd files. Border files
must have a large central area that is transparent. This means that only files that support transparency like png can be imported
as borders.
If you have a .ONPreset file that you have downloaded from the onOne Software website, simply double-click on it to install it. There is no need to
import it through the Extras Manager.
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Browsing Extras
You can browse and open Extras from the Browse
module. In the Sources pane there are sources
for onOne Extras (extras that are provided by
onOne when you installed Perfect Enhance) and
User Extras where you can browse and open
extras you have installed.
Inside each source folder are folders for the
Backgrounds, Borders and Textures. You can
open these as layers into Perfect Layers to add
them to an image or layout you are working on.

Using Extras in Perfect Layers
Browsing extras in Perfect Layers is similar to the
Browse module. Click on the Extras tab of the left
column mini-browser. You will see top-level folders
for onOne Extras and User Extras. Inside of
these will be sub-folders for Backgrounds,
Borders and Textures. You can double-click on an
extra to add it to your current image, just use the
"Add as a Layer" option when asked how you
want to open the file.

Then you can use the transform
tool to size and position the extra
on your image.
Use the Layers pane to change the
order, opacity and blending mode.
Use the Masking Brush and
Masking Bug to selectively apply
the extra.
Use the Perfect Eraser to remove
distractions from the extra if
needed.
If you save your file as a layered PSD file, you
can always re-open the file again and have
access to all of the layers and masks for further
editing.
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How to use in a Module
You can access certain extras, like borders and
textures, inside of modules like Perfect Effects
and Perfect B&W. To use them follow these
steps:
1. Open an image into Perfect Effects.
2. In the Filter Options pane, select the
correct filter type, either Borders or
Texturizer.
3. From the Category pop-up, select a
category you have imported. User added
extras categories appear at the bottom
of the category list.
4. From the Texture pop-up select a texture
from the category you selected.

How to Delete Extras
You can remove imported extras using the Extras Manager. Follow these steps:
1.
2.
3.
4.

Open the Extras Manager.
Click on the extras type that contains the content you wish to remove. This will display categories within that extras type.
To delete an entire category, select in the left column and click on Delete button in the footer of the left column.
To delete individual extras, select them in the right column and click on the Delete button in the footer of the right column.
Deleting extras is permanent and can not be undone!

Preferences
Note: This page refers to the Preferences dialog for the Perfect Photo Suite. If you have an individual product not all of the options detailed below may
be available.

The preferences dialog contains general application settings. The preferences are accessed from the Perfect Enhance menu on Mac or the Edit menu on
Windows.
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The preferences contain the following controls:

General Settings
1. Working Color Space: When a new file is created or
file is opened and has no color profile associated with it,
this is the assumed color profile for the image. Images
that come from plug-ins or have tagged or embedded
profiles will use the associated profile instead.
2. Scrolling Controls: Lets you select how the mouse
scroll wheel or scrolling gesture works. The options are:
1. None: Default
2. Preview Zoom: Adjusts the zoom of the
preview window. Scrolling up increases the
zoom, scrolling down decreases the zoom. It is
important that the zooming is comfortable, not
too fast or slow or jerky.
3. Preview Pan: Pans the image, like using the
pan tool or navigator. It is important that the
panning is comfortable, not too fast or slow or
jerky.
4. Brush Size: Adjusts the size of the current tool
if relevant, such as a brush tool.
3. Preview Background Color: You may select the color
of the background behind the preview image. The default
color is black. There should be options for black, white,
light gray, dark gray and custom... The custom option a
color picker where you can select your own background
color
4. Start In: Determines which module will open

at launch. Browse is the default.
5. Check of Updates on Launch: Enabled by default,
the product will communicate with onOne server at
launch and if an update is available it will prompt you to
download, or skip.
6. Warn when leaving files in Layers: Enabled by
default, if you have unsaved files open in Layers and
want to close the program a warning dialog will appear
with the options to Save & Close, Cancel, or OK which will
close without saving.
7. Language: Select which language the app user

interface is presented in. Usually this is
determined automatically but the locale of the
operating system but can be manually set.

Plug-ins

1. Smart Photos Save PSD Files As: When you send a
PSD to Perfect Enhance via a plug-in from Lightroom or
Aperture you can choose between saving the file as a
normal photo or a Smart Photo.
2. File Type: Specifies four options. PSD (Supports Layers,
Defaults Setting. Same as Source (PSD for Raw). TIFF
(No Layers). JPEG (No Layers).
3. Color Space: Specifies the color space to use when
processing copies from Lightroom. This is similar to the
working color space pop-up in the general preferences
tab, however there are only the three options supported
by Lightroom: sRGB, Adobe RGB 1998 and ProPhotoRGB.
4. Bit Depth: Sets the bit depth for the copies created by
Lightroom, the options are 8 and 16-bit.
5. Resolution: Sets the resolution of copies created by
Lightroom.
6. Stack with Original: Enabled by default, copies
created by Lightroom are stacked with their original or
source image.
7. Use Original for Single PSDs: Enabled by default. If
your selection is a single PSD file, the original PSD is
opened rather than creating a copy.
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Performance Settings

1. Memory Usage: Specifies the amount of system
memory (RAM) that is used by the application. The
default is 80%.
2. VRAM Usage: Specifies the amount of video memory
(VRAM) that is used by the application. The default 80%.
3. Process 8-bit images as 16-bit: When enabled, 8-bit
images are handled in a 16-bit space to reduce
processing artifacts. This is recommended unless you
have a computer with low memory.
4. Scratch Folder Location: Allows you to move or reset
your memory cache. This is helpful if you have a small
SSD drive as your system drive. This information is
purged after each time you quit the application.
5. Browse Cache: Stores thumbnails previews on disk so
that the next time you browse a folder it loads much
faster. Here you can adjust the memory cache size or
amount of information stored, empty, move, and or
reset.

Services

1. Services in Sources: Control which online storage
services are displayed in the Sources pane in Perfect
Browse.

Perfect Enhance
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Perfect Enhance
Automatic fixes and or fine tune your brightness, contrast, white balance, vibrance, detail, vignette and basic tools.

Some of the features:
Tools for cropping, retouching small blemishes and red eye correction.
Perfect Eraser using content-aware fill technology, removes objects and automatically reconstructs the area.
Enhance colors, vibrancy, dictate contrast, precision temperature control for white balancing.
Automated options for one click correction.
Sharpening for increasing clarity and detail.
Noise Reduction
Complete vignette control with a customizable center.
Preset commands for streamlining the editing process.
What This Means For You
Whether you are a hobbyist photographer or a working professional, the foundation of editing begins in Enhance. This module is
designed for improving the overall quality of the image the genesis of every workflow.

Getting Started
This getting started section will give you the basics of using Perfect Enhance. If you have never used Perfect Enhance
before, this is a good place to start. You might also try watching the getting started video tutorial. For detailed information on
steps and controls mentioned in the getting started section, see the "Using Perfect Enhance" section.

Perfect Enhance Work Space
The Perfect Enhance Main Screen Overview

Perfect Enhance provides you with an easy-to-use work space for editing your photos. Below is an overview of the main sections.
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The main window sections of Perfect Enhance:
A. Presets: Displays a list of categories and presets.
B. Tool Well: This is where the tools are located.
C. Module Selector: This is where you choose which module to use.
D. Tool Bar: This is where information on your selected tool will live.
E. Module Selector: This is where you choose which module to use.
F. The Navigator, Loupe, Histogram and Info Panes.
G. Quick Fixes Pane: This pane gives you fast, intuitive buttons for the most common adjustments.
H. Color & Tone Adjustments Pane: This pane will give you more advanced settings to adjust both the color and tone of your image.
I. Vignette/Sharpening/Noise Reduction Panes: These panes will help make adjustments to your image.
J. The Cancel/Apply or Cancel/Save&Close Buttons: This is where you cancel or apply an action.

Crop Tool

Trim the and resize the image to your desired size

Perfect Eraser Use this tool to remove distractions like signs and powerlines.
Retouch Brush Use this tool to remove blemishes like dust spots and acne.
Red Eye Tool

Use this tool to remove red-eyes.

Hand Tool

Adjusts the photo position in the preview area.

Zoom Tool

Adjusts the magnification of the image in the preview area.

Navigating the Preview
Perfect Enhance provides several ways to navigate and view your image in the Preview window.
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The Preview Window above is the main section where you preview and work on images.
Hand Tool
The Hand tool is used to position the image within the Preview window, whenever the preview zoom is larger than the viewable area.
To pan (scroll) in the Preview window:
Select the Hand Tool and drag the image until you locate the area you wish to view.
With any other tool selected, hold down the spacebar while you drag the image in the window.

Double-click the Hand tool in the Toolbar to set the image to a magnification that fits completely in the current window size.

Zoom Tool

The Zoom tool changes the magnification of the image in the Preview window.
With the Zoom tool selected:
Click in the Preview window to zoom in and center the image at the location clicked.
Click and drag in the Preview window to draw a rectangular, the screen fills with the area within the rectangle when you release the mouse.
Hold the Option key (Mac) or Alt key (Win) and click to zoom out.

Double-click the Zoom tool in the Toolbar to set the image to 1:1 or 100% magnification, showing every pixel. This is best when examining small details.

Navigator, Loupe, Histogram and Info
At the top of the control panel on the right of the main window is the Navigator | Loupe | Histogram | Info panes. It contains four useful tools for
inspecting and viewing details of your image.
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The Navigator Pane
This gives you a birds-eye view of your image. The white rectangular region marks the
image area that is visible in the preview pane. You can pan your image by clicking and
dragging inside the blue region.
At the bottom of the Navigator pane are several Zoom presets. Click on a Zoom preset to
activate.
FIT: Zooms to fit the current canvas size. This allows you to see your entire image.
100: Zooms to 100% or actual pixels. This is best for judging small details.
50: Zooms to 50%
25: Zooms to 25%

The Loupe Pane
This gives you a magnified view of the section of the preview under the cursor. This allows
you to view the quality of your results while maintaining a complete view of your image.
At the bottom of the Loupe Pane there is a slider for adjusting the zoom level.

The Histogram Pane
This gives you a color chart of the shadow, mid-tone and highlight areas based on the
image RGB values. This is useful to show areas within the image that may be clipping.
Clipping is when your image contains pure blacks or white and can signify loss of highlight or
shadow detail.
The left side of the histogram represents the shadows, while the right represents the
highlights. At the top of each end is a triangle. If the triangle is lit, there is clipping on that
side of the histogram. If you click on the arrows, you will activate the clipping overlay on
your image. The areas of your image with a blue overlay are pure black, while the areas
with the red overlay are pure white. You can turn the clipping view off again by clicking on
one of the triangles. You can also temporarily enable clipping view by holding down the J
key at any time. The clipping view is useful when you are making adjusts to the brightness
and contrast of your image.
The Histogram pane also displays the RGB values under the cursor at the bottom of the
pane.
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The Info Pane
The info pane will display important metadata about your file including:
Camera type
File type
Focal length
Date and time captured
Exposure information
ISO
Shutter Speed
Aperture
Exposure Value
Filename
Color Space
Dimensions and resolution
File Size and Bit-Depth
If your camera allows for GPS the GPS button will be viewable and you can click on it to get
the GPS cordinates for where the image was taken. This feature only works if you have
GPS enabled on your camera or mobile device. Otherwise you will not see the GPS button.
The Info panel is not visible when you access Perfect Enhance as a Photoshop
plug-in.

Using Perfect Enhance
Pages in this Section
Quick Fixes Pane
Color & Tone Adjustments
Vignette
Sharpening
Noise Reduction
Crop Tool
Perfect Eraser
Retouch Brush
Red-Eye Tool
Presets
Module Settings
Menus
Keyboard Shortcuts

Quick Fixes Pane
The Quick Fixes pane is home for common adjustment controls in the form of simple buttons to quickly tune your image. The basic adjustments can be
controlled through these buttons as an alternative to using the sliders. The buttons have two sides, "-" and "+". By clicking on these you can either turn
down(-) or up(+) the intensity of the corresponding adjustment. For even quicker automated adjustments use the "Auto Tone" and "Auto Color" buttons.
Click "Reset All" to start over and revert to the original image.
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Auto Tone: This button sets the white and black point automatically. The Auto
button in Tone adjustments Pane will also do the same.
Auto Color: This button will attempt to remove the color cast and correct the
white balance. The Auto button in Color adjustments will do the same.
Fix Focus: This button will help correct the focus on your image.
Brightness: This button will adjust the Brightness slider 10 points with each click.
Contrast: This button will adjust the Contrast slider 10 points with each click.
Vibrance: This button will adjust the Vibrance slider 10 points with each click.
Shadows: This button will adjust the Shadows 10 points with each click.
Highlights: This button will adjust the Highlights 10 points with each click.
Color: This button will adjust the Color or Temperature 10 points with each click.
Noise: This button will remove the Noise in your image 10 points with each click.
Detail: This button will adjust the Detail in your image 10 points with each click.
Vignette: This button will adjust the Vignette slider 10 points with each click.

Color & Tone Adjustments
The Color & Tone Adjustments Pane provides the tools needed to correct and enhance the brightness, contrast, detail and color in your images.

Tone
The Tone sliders control the global tonality, or brightness and contrast of the image. You can
adjust each of the following:
Brightness: Adjusting the slider to the right will lighten your image. Adjusting to the left will
darken your image.
Contrast: This will increase or decrease the contrast in your image.
Shadows: This slider lightens the shadows, revealing details.
Highlights: This slider darkens the highlights, recovering detail.

Levels
The Levels sections sets the white and black points which are key to gaining good contrast. Every
image should have at least some pure white and black. It is handy to watch the histogram and/or
use the clipping overlay when adjusting the levels.
Auto Button: The auto button sets the white and black points automatically.
Whites: This slider will clip the whites adding more contrast to the whites.
Blacks: This slider will clip the blacks adding more contrast to the blacks.
Detail: Increases the detail or structure in your image.

Color
The Color sliders control Temperature, Tint and Vibrance. They are used to remove a color cast
and enhance the color of the image.
Auto Button: The auto button attempts to detect and remove a color cast. It makes
adjustments to the Temperature and Tint sliders.
Temperature: This slider will shift the color either cooler or warmer (Blue/Orange).

Tint: This slider will shift the color either green or magenta.
Vibrance: This slider controls the vibrance of the colors.
Reduce Vibrance on Skin: When turned on, adjustments made with Vibrance slider are
reduced on skin colored areas. This allows you to increase the vibrance of clothing and the
background without adversely affecting the skin color.
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Gray Dropper
The Gray Dropper is used to remove a color cast or "neutralize" the image. Click the icon to
activate, the cursor will change to the Gray Dropper. Click an area in the image that should be
gray with no color and the sliders will automatically adjust according to the sample you have
selected.

Reset: will revert to the original image and set all the sliders back to the zero
value.

Vignette
The Vignette pane creates flexible vignettes which focus the viewers eye toward the center of
the image by darkening distracting edges. Use the Preset Buttons to quickly apply a vignette and
customize the look with the advanced controls. Use the global on/off button to toggle the vignette
effect on or off.
Preset Buttons:
None: Reverts to the default, no vignette.
Subtle: Adds a soft oblong vignette.
Strong: Adds a stronger oblong vignette.
Edges: Adds a rectangular vignette.
The hidden Advanced controls can be expanded by clicking the triangle.
The Preset drop down menu contains additional vignette presets.
The sliders may be used for fine tuning the look of the vignette.
Brightness: Controls how light or dark the vignette is.
Size: Controls the size of the vignette.
Feather: Controls the hardness of the edge of the vignette.
Roundness: Controls the shape of the vignette from square to round.
Style: This drop down menu will allow you to select either a normal, subtle or soft
vignette.
The Center Tool allows you to select the center point of the vignette. Click on the tool icon to
activate and then click on the area in the image you wish to make the center.
The Reset button will return the setting to the default with no vignette.

Sharpening
The Sharpening pane contains the controls for increasing the sharpness of the image. Use the
Preset Buttons to quickly apply sharpening and customize the look with the advanced controls. Use
the global on/off button to toggle the sharpening effect on or off.
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Preset Buttons
None: Default setting that applies no sharpening.
Fix Focus: Applies high-pass sharpening, perfect for making an out-of-focus image appear
in-focus.
Screen: Perfect for images that will be viewed on computer screens.
Print: Perfect for images that will be printed.
The hidden Advanced controls can be expanded by clicking the triangle.
The Sharpen For drop down menu includes additional presets based on the output type including
paper and subject matter types.
The Type drop down menu includes the three sharpening methods; progressive, high-pass and
unsharp mask.
The Sliders may be used for fine tuning the sharpening effect.
Amount: Controls the overall amount of sharpening.
Protect Dark: Reduces the sharpening on shadow tones.
Protect Lights: Reduces the sharpening on highlight tones.
Protect Skin: Reduces the sharpening on skin colored areas.

The Reset button will return to default settings that applies no sharpening.

Noise Reduction
The Noise Reduction pane contains the controls for decreasing the noise or grain in your image. Use
the Preset Buttons to quickly reduce noise or customize the look with the advanced controls. Use
the global on/off button to toggle the noise effect on or off.

The noise reduction filter is used to reduce both luminance and color noise while maintaining image
detail.
Preset Icons: Presets for a quick adjustment.
Luminance: Adjusts the overall strength of the noise reduction applied to the luminance or
detail of the image. Hold down the alt key to see just the luminance while adjusting this
slider.
Color: Controls the amount of noise reduction applied just to the color or chroma of the
image.
Detail: Controls how much edge detail is protected. Hold down the a alt key see the the
edge mask while adjusting this slider.
Automatically Zoom to 1:1: It is important that you view your image at 100% or 1:1
when adjusting noise reduction controls. This automatically zooms in for you.
Apply to: Allows you to limit the noise reduction to just a portion of the image based on
color or brightness.
Dropper: Sets a custom color range to apply the noise reduction to.
Range: Adjusts the range or fuzziness of the color range to apply the noise reduction to.
Reset will return the settings to the default.

Crop Tool
Crop Tool: This is used to crop and resize the entire image. The crop tool removes any pixels outside a crop box
and changes the canvas size at the same time. To crop the image, select the Crop Tool from the tool well. Then
adjust the corner handles of the crop tool overlay. The area outside the crop box appears darkened for guidance. You
can resize and move the image inside the crop box. When you are satisfied with your settings, press the Apply button
in the Tool Options Bar or press enter.
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Moving the Image: To move the image inside the crop box,

simply click and drag inside the box. You can also nudge the
image using the arrow keys on your keyboard.
Resizing a Crop Box: To resize the Crop Box, click and drag

on any of the resize handles. Clicking on a corner handle
allows you to adjust two sides at the same time. Clicking on
a side handle allows you to adjust that side. If you hold the
shift key down while adjusting the size, the proportions of
the box are maintained. To rotate the crop box, move
outside a corner until the tool changes to rotate. You
can also set the aspect ratio or size of the crop box in the
tool options bar.

The Crop tool is not available when using a Smart Photo.

Crop Tool Options

Preset pop-up: Pop-up controls the crop tool mode as well as aspect ration and document size presets.
Width: Sets the width of the crop box.
Swap Dimensions: Swaps the width and height. Handy for rotating the crop box.
Height: Sets the height of the crop box.
Units: Determines the unit of measure: Pixels, inches, centimeters, etc.
Leveling Tool: Click and drag this tool across an element in your image that should be level.
Angle: See and adjust the angle of rotation.
Rotate: Rotates the image 90 degrees.
Cancel: Resets the crop tool.
Apply: Applies the crop and resizes your photo.
Crop Tool Modes

The Crop Tool works in three modes:

Freeform: In this mode you can adjust the crop box
any way you like. The image will not be resized. Any
area outside the crop box will be trimmed off. Use
this mode if you just want to change the shape or
recompose your image for general use.
Aspect Ratio: You can lock the crop box to an
aspect ratio. This makes sure the crop box shape
doesn't change, just the size. Use this option to
trim existing pixels while maintaining a ratio without
resizing the image.
Document Size Presets: Document Size Presets
allow you to crop and resize your image at the same
time. If you know your intent is to print the image at a
certain size you can crop and resize the image at the
same time. Many common sizes are included plus you
can create your own.

Leveling the Image
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The Crop Tool has a special Leveling Tool for automatically rotating your
image to be level.
1. Select the Crop Tool.
2. Select the Leveling Tool from the Crop Tool Options

Bar. Your cursor will change to the Leveling Tool.
3. Click and drag a line across your image that should be

level, either horizontally or vertically. When you
release the mouse the image will be rotated
automatically to the correct angle.

Perfect Eraser
The Perfect Eraser can be used to remove distracting elements and blemishes from your image.

How it Works
The Perfect Eraser employs a content aware
algorithm that replaces the pixels with a natural
and plausible result within the boundaries that are
painted.

Using the Perfect Eraser
Activate the tool by selecting it in the Tool-Well. Simply paint over the area you wish to remove. Make sure you cover the entire area. A red overlay
appears where you paint. You can adjust the size of the brush using the Tool Options bar.
If the first attempt does not give you a perfect result, simply paint over it again and it will improve with each pass. You can also fine tune the area after
using the Retouch Brush.

Retouch Brush
Retouch Brush: Use the Retouch Brush to remove small imperfections like dust or blemishes. Just dab the retouch

brush on spots like acne, dust spots, power lines, etc. It looks at the neighboring areas and fills in the brush with
similar color and texture. It is best to use the smallest brush size possible and to work by dabbing rather than making
large brush strokes. If you dab with the Retouch Brush and don't like the results, use the undo command and try using
a smaller brush or vary your brush stroke and try again. The Retouch Brush is perfect for retouching skin.
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You can control the Retouch Brush using the Tool Options Bar

Brush Size: This adjusts the overall size of the brush.
Brush Feather: This adjusts the hardness of the brush. It
works best to use a feather larger than 50 to blend and look
natural.
Brush Opacity: This adjusts how strong the retouching is.
Use 100% to completely remove an imperfection. Use a lower
opacity to soften them.
W: If you have a Wacom pressure sensitive tablet, you can
adjust the size of the brush according to the pressure. Click
on the "W" in the box to activate the Wacom
sensitivity controls.

Red-Eye Tool
Red-Eye Tool: To instantly reduce red-eye.

The Red-Eye Tool is the perfect tool for eliminating or reducing red eye
in your images. It's a simple one-click stamp that will immediately take
care of red eye.
You start by selecting the red eye brush in your Tool-Well. Next adjust
your brush size to be as close to the same size as the red eye you are
wanting to remove. Then place brush right over the eye and click once
to remove.
The Protect Skin toggle reduces the tools affect on skin colored areas.
It is on by default. If the red-eye reduction is not strong enough, try
toggling this off.

Presets
Presets store all of the adjustments you make in Perfect Enhance. Presets are a fast and easy way to get consistent results. You can save your own presets
for batch processing or for simply reproducing your look when retouching.

Presets do not store masks created by tools other than the Masking Bug.
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Using a Preset
Using a preset is simple, just click on it in the Preset Browser.

Saving a Preset
Saving a preset is simple. Once you have your settings that you wish to
save, go to the Preset menu and select Save Preset.
The New Preset dialog will appear (shown to the right). There are several
fields to complete including the preset name, the category, creator and
description.
In the category pull-down you can select which existing category the
preset should saved into. You can also create a new category this way by
selecting new category from the bottom of the list.
You can edit a preset's name, creator or description by selecting
it and then selecting Edit Preset Info from the Preset menu. If
you want to edit the settings in a preset, load it into, make your
adjustments and then re-save the preset with the same name
and location.

Deleting a Preset
You can remove a preset if you no longer want to have access to it. To
remove a preset, follow these steps:
1. Select the preset you wish to remove in the preset browser.
2. Select Delete Preset from the Preset menu.

Importing & Sharing Presets
You can import presets you have downloaded from the onOne website
using these steps.
1. Download the preset pack from the onOne website. It should have
a .ONPreset extension.
2. Double-click on the preset pack, it will install the presets into a
category named the same as the preset pack.
That's it, next time you use Perfect Enhance the new presets will be
located in the My Presets tab, in a category named after the preset pack.
You can delete the files you downloaded, they have been copied into
Perfect Effects.
You can share presets like you would share any other file, such as email or
posting them to a website. First you need to find the preset files. The
easiest way it to open Perfect Enhance then from the Preset menu select
Show Presets Folder. A window will open and will display the presets
folder. In the presets folder are sub-folders for your preset categories.
Inside each sub-folder are the individual preset files. You can copy these
presets to another computer, attach them to an email or post them on a
website.

Module Settings
The Perfect Enhance settings dialog contains options for customizing your experience at launch.
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Default Settings
The default settings section allows you to control what
adjustments are applied each time you open an image in
Enhance.

No Changes: The default option leaves the
image is, no automatic adjustments are
made upon opening Perfect Enhance.
Automatic Enhancement: Automatically
adjusts the brightness, contrast, and color.
My Settings: Uses settings from the
preset selected in the drop down. You may
choose a factory preset or customize your
own look and save the preset and use it as
a default adjustments that take place at
launch. See the Presets page for more
information.
Apply Results
Apply to the Current Image Layer.
Apply to a Copy of the Current Layer will make a
new layer on the image with Enhance adjustments.

Menus
Perfect Enhance
About Perfect Enhance: Opens the about box. This dialog contains
your serial number, version number and information on contacting
onOne Software for support.
Preferences: Opens the preferences dialog.
Quit Perfect Enhance: Quits the application.

File
Save & Close: Applies the current settings to your image and returns
to the host application.
Cancel: Cancels Perfect B&W and returns back to the host application
with no changes.
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Edit
Undo: Reverses the last user action.
Redo: Reapplies the last user action if it has been undone.
Cut: Unused.
Copy: Unused.
Paste: Unused.
Reset All: Resets all controls back to their default settings.
Module Settings: Adjust any automatic changes to your images when
Enhance is launched.
Preferences (Windows Only): Opens the Perfect Enhance
preferences dialog.

Preset
Save Preset: Saves the current settings as a new preset.
Import Preset: Opens the import preset dialog to help you import
presets you have downloaded.
Show Presets Folder: Opens a Finder or Explorer window showing the
presets folder.
Delete Preset: Deletes the current preset.
Edit Preset Info: Opens the preset dialog so you can edit the name,
author or description information.
Manage Extras: Opens the Extras Manager where you can import and
manage extras like Borders, Backgrounds, Textures and Presets.

View
Zoom In: Zooms the preview window in one increment. This will make
the preview image larger.
Zoom Out: Zooms the preview window out one increment. This will
make the preview images smaller.
Fit to Screen: This sets the preview image so that the entire image is
on screen at once. Think of this as an overview of the entire image. This
is the setting you will use most of the time.
Actual Pixels: This sets the preview image so that it zooms to actual
pixels or 1:1 also called 100%. This setting allows you to see every pixel
in the image. This is useful when making precision adjustments.
Show Browser Pop-up: Enables the browser pop-up window.
Browser Mode: Allows the user to select how the Browser Library
displays the categories.
Show Clipping: Shows the clipping overlay view, which over-rides the
current mask view.
Show Preview: Toggle to enable or disable the preview.
Preview Background Color: Toggles the background color options.
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Window
Navigator: Hides or shows the Navigator, Loupe, Histogram and Info
pane.
Quick Fixes: Hides or shows the Quick Fixes pane.
Color & Tone Adjustments: Hides or shows the Color & Tone
Adjustments pane.
Vignette: Hides or shows the Vignette pane.
Sharpening: Hides or shows the Sharpening pane.
Solo Mode: Enables solo mode. When Solo Mode is enabled, only one
control pane may be open at a time.
Show Browser Panel: Hides or shows the Browser Panel.
Show Control Panel: Hides or shows the Control Panel.
Hide Panels: Hides or shows all Panels.
Full Screen: Toggles to and from full screen mode.
Document Name: Shows the name, zoom level and bit depth of the
open image.

Help
Search: Searches the menu options (Mac OSX only).
Perfect Enhance Online Help: Opens this html Help in your default
web browser.
Video Tutorials: Opens the online Video Tutorial in your default web
browser.
Getting Started: Opens the online Getting Started overlay.
Show Keyboard Shortcuts: Opens the keyboard shortcut inspector.
Perfect Inspiration: Takes you to the Perfect Inspiration web site.
Check for Updates: Checks with the onOne update server to see if
you are running the current version. If there is a newer version you will
be notified and be walked through the update process.
Provide Feedback: Opens the default web browser and navigates to
the feedback page of the onOne website.
About Perfect Enhance (Windows Only): Opens the about box
with the version number and license code displayed.
Help Improve onOne Products: Opens the Improve onOne Products
dialog.

Keyboard Shortcuts
Action

Mac

Win

Print

cmd p

ctl p

Undo

cmd z

ctl z

Redo

cmd shift z

ctl shift z

Cut

cmd x

ctl x

Copy

cmd c

ctl c
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Paste

cmd v

Save Preset

cmd shift s

ctl v
ctl shift s

Zoom-In

cmd +

ctl +

Zoom-Out

cmd -

ctl -

Fit to Screen

cmd 0

ctl 0

Actual Pixels

cmd opt 0

ctl opt 0

Next Browser View Mode

cmd B

ctl B

Navigate Browser Selection

Arrow Keys

Arrow Keys

Open Selected Category

Right Arrow

Right Arrow

Close Selected Category

Left Arrow

Left Arrow

Show Clipping

opt J

opt J

Show Preview

cmd p

ctl p

Navigator/Loupe/Histogram

cmd 1

ctl 1

Quick Fixes

cmd 2

ctl 2

Color & Tone Adjustments

cmd 3

ctl 3

Vignette

cmd 4

ctl 4

Sharpening

cmd 5

ctl 5

Noise Reduction

cmd 6

ctl 6

Show Browser Panel

cmd left arrow

ctl left arrow

Show Control Panel

cmd right arrow ctl right arrow

Hide Panels

tab

tab

Full Screen Mode

cmd ctl f

F11

Keyboard Shortcuts

cmd shift k

ctl shift k

Pan Tool

h

h

Perfect Eraser

q

q

Crop Tool

c

c

Red Eye Tool

e

e

Retouch Brush

r

r

Zoom Tool

z

z

Brush Size

larger ]
smaller [

larger ]
smaller [

Brush Feather

softer shift ]
harder shift [

softer shift ]
harder shift [

Brush Opacity

opt 1 (10%)
opt 2 (20%)
opt 0 (100%)
etc

opt 1 (10%)
opt 2 (20%)
opt 0 (100%)
etc

Toggle Tool Mode

x

x

Temporarily Select Hand tool

Hold Spacebar

Hold Spacebar

Temporarily Toggle Tool Mode

Hold opt

hold alt

Temporarily Toggle Clipping View j

j

Rotate Crop Clockwise

opt right arrow

alt right arrow

Rotate Crop Counter Clockwise

opt left arrow

alt left arrow
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